
REALbasic QuickStart

Welcome to REALbasic!

REALbasic is an application builder based on a modern version of the BASIC 
programming language. The REALbasic development environment is made up of a 
rich set of graphical user interface objects (commonly referred to as a GUI), an 
object-oriented language, a debugger, and a compiler. 

With the graphical user interface, you can build your application’s interface simply 
by dragging and dropping interface objects into the application’s windows and 
dialogs.

Together with REALbasic’s object-oriented language, debugger, and cross-platform 
compiler, it makes up REALbasic’s Integrated Development Environment (IDE), 
designed to make application prototyping and programming easy.

REALbasic provides you with all the tools you need to build virtually any 
application you can imagine.

If you are new to programming, you will find that REALbasic makes it fun and easy 
to create full-featured applications. If you are an intermediate or advanced program-
mer, you will appreciate REALbasic’s rich set of built-in tools.

This QuickStart is for people who are new to programming and new to REALbasic. 
It will give you a gentle introduction to the REALbasic development environment, 
lead you through the development of a real application, and show you what kinds of 
other applications can be built with REALbasic. 

It should take you no longer than 30 minutes to complete this QuickStart.
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Note If you have experience with other versions of the BASIC language or have experience 
with other programming languages, you’ll want to check out the Tutorial and User’s 
Guide. In the Tutorial, you’ll develop a more complete application, which includes 
menus, dialog boxes, and objects called classes.

Presentation Conventions
The QuickStart uses screen snapshots taken from the Windows, Macintosh, and 
Linux versions of REALbasic. The interface design and feature set are identical on 
all platforms, so the differences between platforms are cosmetic and have to do with 
the differences between Windows XP’s standard appearance setting, the 
Macintosh’s Mac OS X interface, and Linux’s ‘Bluecurve’ desktop that ships with 
Red Hat Linux.

Italic type is used to emphasize the first time a new term is used, and to highlight 
important concepts. In addition, titles of books, such as REALbasic User’s Guide, are 
italicized. 

When you are instructed to choose an item from one of REALbasic’s menus, you 
will see something like “choose File . New Project”. This is equivalent to “choose 
New Project from the File menu.” 

The items within the parentheses are keyboard shortcuts and consist of a sequence of 
keys that should be pressed in the order they are listed. On Windows and Linux, the 
Ctrl key is the modifier; on Macintosh, the x (command) key is the modifier. For 
example, when you see the shortcut “Ctrl+O or “x-O”, it means to hold down the 
Control key on a Windows or Linux computer and then press the “O” key or hold 
down the x key on Macintosh and the press the “O” key. You release the modifier 
key only after you press the shortcut key.

Bold is used to indicate text that you will type while using REALbasic. 

Some steps ask you to enter lines of code into the REALbasic Code Editor. They 
appear in Frutiger (a sans serif font) in a shaded box:

When you enter code, please observe these guidelines:

n Type each printed line on a separate line in the Code Editor. Don’t try to fit two or 
more printed lines into the same line or split a long line into two or more lines.

n Don’t add extra spaces where no spaces are indicated in the printed code.

Whenever you run your application, REALbasic first checks your code for spelling 
and syntax errors. If this checking turns up an error, REALbasic will direct your 
attention to the line of code that is causing problems. Check the line against the 
printed line. The QuickStart includes troubleshooting sections that help you handle 
syntax errors.

ShowURL SelectedURL.Text
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Starting REALbasic
Starting REALbasic
If you haven’t done so already, install REALbasic on your computer. If you are using 
the Macintosh version of REALbasic, drag the REALbasic folder from your CD to 
your Applications folder (or another folder of your choice). If you are using the 
Windows or Linux versions of REALbasic, use the appropriate REALbasic installer 
to install the product and all the necessary files onto your computer. For Linux, 
there are separate .rpm packages for Red Hat and Novell SuSe Linux as well as a tar 
file.

Double-click the REALbasic application icon. In a few moments, the REALbasic 
Integrated Development Environment window appears. 

Figure 1. The Integrated Development Environment (IDE).

The Integrated Development Environment
As you can see in Figure 1, the REALbasic IDE window resembles an internet 
browser window in many ways. The main work area of the window works like an 
internet browser that supports tabbed browsing such as FireFox or Safari. When you 
first start REALbasic, only one tab exists; as you add items to your project, 
REALbasic automatically adds tabs to the IDE window. 

Just below the menu bar (or the Title bar on Macintosh) you see the Main Toolbar. 
Between the Main Toolbar and the Tab bar is the Bookmarks bar. When you first 
start REALbasic, the Bookmarks bar is blank.

The Main Toolbar has Forward and Back buttons for navigating among pages, an 
Address area for moving directly to a particular page, and a Search area for searching 
for an individual object. The Add Bookmark button enables you to add a page to 

Properties pane

Project pane

Editor Toolbar

Main Toolbar

Tabs bar

Tips bar
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The Integrated Development Environment
the Bookmarks menu or the Bookmarks bar for later retrieval. Finally, you use the 
Run and Build buttons in the Main Toolbar to test and build your application.

Figure 2. The Main Toolbar, Bookmarks bar, and Tabs bar.

Below the Bookmarks bar, you see the Tab bar. Only one tab currently exists, for 
the Project Editor. It consists of two panes, the Project Editor and the Properties 
pane, which are shown in Figure 1 on page 3. 

The Project Editor contains a list of all of the major items that make up your 
REALbasic application. For example, it includes items for all the windows that your 
application uses, the menu bars, and objects such as sounds, pictures, databases, and 
movies. By default, it includes an item for the application’s main window, 
Window1, its default menu bar, MenuBar1, and an item associated with the 
application as a whole, App. You double-click an item in the Project Editor to edit 
or view it. 

On the right side of the Project Editor, you see the Properties pane. It lists the 
properties (or attributes) of the item that you select in the Project Editor. In the case 
of Figure 1, no item is highlighted, so the Properties pane is initially blank. 

If you click on the Window1 item, the Properties pane changes to show Window1’s 
properties. Some of its properties specify its size, its type (e.g., a document window, 
dialog box, a floating palette, and so forth), and attributes such as its menubar, and 
whether it will have a Close box.

For example, the properties in the ID group give the Name of the window 
(Window1) and the Super property tells you what type of object it is. The properties 
in the Position group show the minimum, maximum, and current size of Window1; 
it is 300 by 300 pixels. You will learn more about properties later in the 
QuickStart.

Below the Tab bar, you will see the Editor Toolbar for the Project Editor. You click 
on an item in the Editor Toolbar to add an item to the project. Each type of item 
listed in the Project Editor has its own Editor toolbar. You will learn about the 
items in the Editor Toolbar in the Users Guide.

In addition, the complete REALbasic documentation set is online. Pull down the 
Help menu; the first four items display the QuickStart, Tutorial, Users Guide and 
Language Reference. Use it as a convenient alternative to the printed or electronic 
(PDF) versions of the documentation.

Main Toolbar

Bookmarks bar

Location area Search Area
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Getting Started
Getting Started
In this QuickStart, you’ll build an application that manages URLs and email 
addresses. A URL (which stands for Uniform Resource Locator) is the address of a web 
page that you type into the Address area in your web browser. This application will 
launch your default web browser application and display the web page that you 
entered.

Figure 3 shows a URL in an internet browser’s Address area:

Figure 3. A URL entered into a browser.

If you enter an email address instead of a URL, the application will launch your 
email application, create a new blank email, and enter the address into the “To” box. 
Figure 4 shows how to enter an email address into a browser’s Address area.

Figure 4. An email address entered into a browser’s Address area.

When you are finished, the application will look like Figure 5. In Figure 5, the 
labels in bold indicate the types of controls that were used in creating the 
application. The functions of the controls are described in plain type.

Figure 5. The finished URL Manager application.

You use the EditField to enter the URL or email address you want and then click 
the Connect button. To save it in the list, you click the Add button. To select a 
URL in the ListBox, highlight it in the list and then click Connect. If you don’t 
need the URL any more, highlight it in the list and then click the Delete button.

Enter URL or email 
address

Click to add to list

Click to copy to the 
text box

Click to delete from list

Click to connect to 
web page or email 
client

ListBox

PushButton

EditField
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Creating the Interface
The application uses three types of prebuilt interface elements to do most of the 
work for you: 

n A ListBox is the type of control that holds scrollable lists. It can hold both single- 
and multiple-column lists and scroll horizontally and vertically.

n An EditField is the type of control that holds text. It can be used to hold either a 
single line of text (as it is here) or as a text editor.

n A PushButton is a standard pushbutton. It is most often used to initiate an action 
(as it is here).

Creating the Interface
Your first task is to build the interface. You already have the REALbasic IDE 
window open.

n Double-click the Window1 item in the Project Editor.

REALbasic creates a new tab for Window1 and displays it in its Window Editor. It 
replaces the Project Editor in the viewing area. Notice that the Tab bar now shows 
two tabs, with the Window1 tab selected. The tab for the Window Editor has a 
close box that you can use if you want to put the editor away. 
The editor for Window1 is shown in Figure 6.

Figure 6. The Window Editor for Window1.

The Window Editor is divided into three panes. The pane on the right is the 
Properties pane and it shows the properties of the selected item in the Window 

Controls pane

Window editing 
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Editor Toolbar
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Creating the Interface
editor. In Figure 6, the window is selected, so the Properties pane shows the 
properties of the window.

The center pane is the window editing area. It is where you design the window. In 
Figure 6, the Window is blank because you haven’t added any interface items yet. It 
shows only a default document window.

The pane on the left is the list of controls or interface elements that you can add to a 
window. Above the list is a pop-up menu that controls the types of interface 
elements the list displays. When set to “Built-in Controls” it shows the complete 
list of built-in REALbasic interface elements. It contains items for the ListBox, 
EditField, PushButton, and many more. You can add a control to a window simply 
by dragging it from the list to a location in the window.

1 In the Controls pane, hold down the mouse button on the ListBox item and drag it 
to the top-left corner of the window in the window editing area.
As you drag toward the corner, alignment guides will appear, as shown in Figure 7.

Figure 7. Alignment guides help you position the ListBox and align other controls.

2 Release the mouse button. 
A square ListBox appears in the Window Editor.

3 Use the resizing handle in the bottom-right corner of the ListBox and drag 
diagonally to enlarge the ListBox. When the alignment guide appears on the right, 
release the mouse button, as shown in Figure 8.
7REALbasic QuickStart



Creating the Interface
Figure 8. Enlarging the ListBox.

Center it in the upper area of the window, as in Figure 8.

4 Next, drag a PushButton control from the Controls pane to the lower-left corner of 
the window (where the “Add” button in Figure 5 on page 5 is). 
As you drag toward the left edge of the ListBox, a vertical alignment guide appears. 
Use the vertical alignment guide to position the PushButton, as shown in Figure 9.

Figure 9. Aligning the Add PushButton.
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Creating the Interface
5 With the PushButton selected, press Ctrl+D (Windows and Linux) or x-D 
(Macintosh) or choose Edit . Duplicate to make a copy of the PushButton. Move it 
to the right of the previous button and align it with the right edge of the ListBox.

When you reach the approximate position, both vertical and horizontal alignment 
guides appear. Align the baselines of the two PushButtons’ captions, as shown in 
Figure 10.

Figure 10. Aligning the Add and Connect PushButtons.

6 With this PushButton selected, press Ctrl+D (Windows and Linux) or x-D 
(Macintosh) or choose Edit . Duplicate to make a copy of the PushButton and drag 
the PushButton upward vertically, just below the ListBox. Release the mouse 
button when the horizontal alignment guide appears.
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Creating the Interface
Figure 11. Adding the Delete button.

7 In the Controls pane, hold down the mouse button on the EditField and drag it into 
position in the window, midway between the Delete and Connect buttons (see 
Figure 12 on page 11).

8 Align the left edge of the EditField with the left edge of the ListBox. 

9 Use one of the EditField’s selection handles on its right to stretch it so that its right 
edge aligns with the right edge of the ListBox.
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Creating the Interface
Figure 12. If Aligning the right side of the EditField with the ListBox and Pushbut-
tons.

If you find that the top button, the EditField, and the bottom row of buttons are not 
evenly distributed, you can reposition a control by clicking on it and moving it one 
pixel at a time using the arrow keys.

Your application’s interface is now complete! It should look like Figure 13:

Figure 13. The finished interface in the REALbasic IDE.
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Creating the Interface
Before going any further, save the project. 

n Choose File . Save (Ctrl+S or x-S) and name it URL Manager. 
At this point, you can actually try it out. Of course it won’t do anything since we 
haven’t told any of the interface elements what to do.

1 Just for fun, click the Run button in the Main Toolbar.
REALbasic builds the application and opens it in its own window. 

The first version of the application should look like this:

Figure 14. The first version in the debugging environment.

In this state, the PushButtons work — that is, you can click them and they 
highlight — but they don’t do anything because we haven’t told the PushButtons 
what to do when they’re clicked. You can enter text into the EditField — but it 
doesn’t go anywhere because there are no instructions to process this text. And the 
ListBox is all set to display and scroll items but we don’t have any way to get text 
into the ListBox yet.

Notice that the application has File and Edit menus. The File menu has one item, 
Exit (or Quit on Macintosh) that quits the application and returns to the REALbasic 
IDE. The Edit menu has the standard Undo, Cut, Copy, Paste, Delete, and 
Select All menu items. Initially these items are all disabled, but you can enable 
them by entering and selecting text in the EditField.

2 Type some text in the EditField and then pull down the Edit menu. 
Notice that the Select All menu item is enabled.

3 Choose Edit . Select All and then choose Edit . Cut.
When you cut text to the Clipboard, the Paste item becomes enabled. All of the 
standard Edit menu items work on text without any programming on your part.

Now we need to go back to the REALbasic IDE to get this application operational.
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Giving Objects Meaningful Names and Labels
4 Choose File . Exit on Windows or Linux (or My Application . Quit on Mac OS X) 
to return to the REALbasic IDE. On Windows and Linux, you can also quit the 
application by clicking the window’s Close box.

Giving Objects Meaningful Names and Labels
You’ve already noticed that quite a few objects use the default label “Untitled.” 
They also have default names like PushButton1, PushButton2, etc. Before getting 
too far into the project, we should give the objects meaningful names and labels. 
You refer to the object’s names in your REALbasic code and, of course, the labels are 
presented to the user. You should give each object that you refer to in your code a 
meaningful name at the start of the project.

1 If it is not already selected, click on the Window1 tab in the Tab bar to bring 
Window1’s Window Editor to the front.

2 Click on the surface of the window in the Window Editor — not one of the controls 
in the window — and then take a look at the Properties pane.

The window has the default name “Window1”, which is shown in the first line. If it 
shows some other name, then you clicked on one of the controls in the window 
rather than the surface of the window itself.

Figure 15. Window1’s Properties Window.

The text that appears in the Title bar of the window is the Title property. The 
Name property is the name of the window that you use in your code to refer to the 
window. 

3 Select the default Title, “Untitled”, in the Properties pane and replace it with the 
text URL Manager, and press the Enter key (Return on Macintosh). When you press 
Enter or Return, the new title appears in the Title bar of the Window Editor as well 
as in the Properties pane.

Object Name

Default position 
and size

Default window type

Window Title
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Giving Objects Meaningful Names and Labels
Figure 16. Changing Window1’s Title property.

Similarly, we need to replace the default names and labels for the controls in the 
window.

4 In the Window Editor, select the Untitled button in the lower left corner by 
clicking on it. 
Notice that the Properties pane changes to show the properties of this PushButton. 
The three PushButtons are named PushButton1, PushButton2, and PushButton3. 
They were named in the order they were created. We’ll never remember which one 
is which, so it’s best to rename them at the same time we’re entering their labels.

5 Change this PushButton’s Name property to AddURL and its Caption property to 
Add. Press Enter (or Return on Macintosh) after typing each entry to save each new 
property value.
Notice that the Caption text immediately replaces “Untitled” in the Window Edi-
tor when you press Return. When you are finished, the Properties pane for the 
AddURL PushButton should look like this.

Figure 17. The Properties pane for the Add button.
14 REALbasic QuickStart



Giving Objects Meaningful Names and Labels
6 Click on the Untitled button in the lower right to select it. It’s PushButton2. Use 
the Properties pane to change its name to ConnectURL and its Caption property to 
Connect.

7 Click on the Untitled PushButton between the ListBox and the EditField and 
change its Name property to DeleteURL and its Caption property to Delete.

8 Click on the EditField and change its name to SelectedURL.

9 Click on the ListBox and change its Name property to ListURL.
That takes care of it. The Properties panes for these objects should look as shown in 
Figure 18.

Figure 18. The Properties Windows for the other controls.

Check your work to be sure that the items are named correctly. If there is a spelling 
error in a Name property, the code that is supposed to refer to that item will not 
work.

In the Window Editor pane the three buttons should now look like this:

Figure 19. The three PushButton controls after renaming.

10 Choose File . Save to save your changes. Click the Run button in the Main Toolbar 
to test the application.
It doesn’t do any more than the last version, but at least all the interface elements 
are labeled correctly.

11 When you are finished testing the application, choose File . Exit (on Windows and 
Linux) or My Application . Quit (on Mac OS X) to return to the REALbasic IDE. 
On Windows and Linux, you can also quit out of the test application by clicking the 
window’s Close box.

Connect button Delete button EditField ListBox
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Making the URL Manager Do Something
Be sure to quit out of the built application before resuming your work in the 
REALbasic IDE.

Making the URL Manager Do Something
Now that the interface is designed and its appearance is touched up, it’s time to 
make the controls do their jobs. We’ll start with the Connect button. Usually you 
specify the action that a button carries out by writing some code that becomes a part 
of the button.

1 In the Window Editor, double-click the Connect button. 
The Code Editor for Window1 appears. This is where you write code for the win-
dow and the controls contained in the window. 

On the left side is a browser area that lists all the controls that we’ve added to the 
window, among other things. (For the QuickStart, we only need to work with the 
controls.) On the right side is the code editing area. It holds the code for the item 
that is selected in the browser.

Right now the “Action” item for the Connect button is selected. It’s highlighted in 
the Browser area and the first line in the editor gives the name of the event.

Figure 20. The Code Editor for Window1.

In order to get the Connect button to do something, we need to write some code 
that will run only when the user clicks this button. Fortunately, the REALbasic 
application itself monitors all user interface activity while the application is running 
and it knows whenever this happens. 

To make the Connect button work, we need to write the instruction that connects 
the user to the web site that the user enters into the EditField. 

In the Browser area of the Code Editor, you’ll see a list of events that REALbasic 
continuously monitors while the application is running. For example, the 

Select an 
event in the 
Browser area

Write code for 
that event in 
the Code 
Editor area

Tips bar
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Making the URL Manager Do Something
MouseEnter and MouseExit events are triggered when the mouse pointer enters the 
region of the PushButton and leaves that region. 

The event we need is the “Action” event. This event takes place when the user clicks 
the button. 

On the right side of the divider, you can write the code that runs automatically 
when the user clicks the button. (Notice that the top line, “Sub Action()”, indicates 
which event the code is for). The instruction to open a web site in the user’s browser 
(or open the email application) is simple. The instruction is ShowURL and its 
syntax is:

Where string is the URL (or email address). 

As soon as you enter “ShowURL”, the syntax for this command appears in the Tips 
bar. By referring to the Tips bar you can avoid having to look up a command’s 
syntax in the Online Reference whenever you need help.

Figure 21. The ‘Tips’ bar showing the syntax for ShowURL.

2 To test out this button, enter the following line in ConnectURL’s Action event:

ShowURL string

ShowURL "http://www.yahoo.com"
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Making the URL Manager Do Something
Be sure to enclose the URL in quote marks. The quote marks indicate that the text 
in quotes is a string (rather than a number or some other type of data). Your Code 
Editor should now look like this:

Figure 22. The code for ConnectURL’s Action event.

3 Click the Run button in the Main Toolbar to test the Connect button.

4 When the application window appears, click the Connect button.
In a few moments, your default web browser will launch and bring up the web page 
you entered. (This, of course, assumes your computer has a connection to the Inter-
net and you have a default web browser application.)

Figure 23. The Yahoo home page.
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Making the URL Manager Do Something
Of course, we need to modify the code so that the text passed to the ShowURL 
command can be entered by the user while the application is running. When we use 
ShowURL "http://www.yahoo.com", the particular URL is “hardcoded.”

Note If you get a syntax error, check to make sure that you spelled the ShowURL 
command correctly, that you enclosed the URL in double quote marks, and that it is 
the correct URL.

5 Choose File . Exit on Windows or Linux (or My Application . Quit on Mac OS X) 
to return to the REALbasic IDE.

We now need to replace the text used with the ShowURL command with the code 
that refers to the contents of the EditField, SelectedURL. 

Since the EditField is named “SelectedURL”, you might think that we could write:

but that won’t work because “SelectedURL” is the name of the object itself. It has 
lots of properties — like its position in the window, whether it takes several lines of 
text or just one, whether it can accept styled text, and so forth. If you use 
“ShowURL SelectedURL”, REALbasic would have no idea what you mean. 
Besides, the ShowURL command only accepts a text string, not a control.

When you need to refer to one of an object’s properties, you write the name of the 
object, followed by a dot, followed by the name of the property. In other words, you 
use this syntax:

It’s sometimes called “dot” notation.

In this case, the EditField is named “SelectedURL” and the EditField property that 
we want is its “Text” property. This means the following expression accesses the 
contents of the EditField:

That is, “SelectedURL” is the name of the object and “Text” is the name of the 
object’s property that we need.

1 In the Code Editor for the Action event, modify the code to read:

This expression SelectedURL.Text refers to the text property only.

ShowURL SelectedURL

objectname.propertyname

SelectedURL.Text

ShowURL SelectedURL.Text
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Making the URL Manager Do Something
Your Code Editor should now look like this:

Figure 24. The revised code for the Action event.

In Case of 
Difficulty

If you have trouble entering this line of text, be sure you have quit out of the test 
application before returning to the REALbasic IDE. Simply quit the test 
application.

2 Save the project (File . Save) and test it by clicking the Run button in the Main 
Toolbar.

3 Enter a URL in the EditField, such as http://www.realsoftware.com and click 
Connect.
Your default web browser should launch and open the web page you entered. 

4 When you’re finished, quit out of the debugging environment (File . Exit on 
Windows and Linux (MyApplication . Quit on Macintosh) to return to the 
REALbasic IDE. 

If the 
Application 
Doesn’t Run

If REALbasic was unable to launch the debugging application, it’s because it 
couldn’t recognize a term you entered into the Code Editor. For example, if you 
misspelled either “ShowURL” or “SelectedURL,” REALbasic stops and points out 
the term it doesn’t recognize. For example, in Figure 25 a user has misspelled the 
name of the EditField. The line that contains the error has a bug to its left and the 
Tips bar contains the error message.
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Making the URL Manager Do Something
Figure 25. A misspelled object name.

Since it can’t find an object called “Select,” it can’t create the application for you. 
REALbasic knows it would never be able to figure out what to do when a user clicks 
the Connect button. Be sure you’ve renamed the controls as described and referred 
to their correct names in the Code Editor. You’ll also get this error if you wrote 
ShowURL SelectedURL and left off the name of the property that contains the 
contents of the EditField.

Another possibility is that you used the correct name in the Code Editor but did not 
rename the EditField using the Properties pane as shown in Figure 18 on page 15. 
In that case, the statement in the Code Editor as shown in Figure 24 ought to work, 
but there is no object named “SelectedURL” in the application. If you get an error 
message, start by checking the highlighted term.

Now, we’ll make the other controls do their jobs.

The Add 
Button

The Add button is supposed to take the text in the EditField and add it to the end 
of the list in the ListBox. That’s easy.

1 If the Code Editor for the window is not already open, double-click the Add button 
in the window (If the Window Editor is not shown, click the Window1 tab in the 
Tabs bar).

2 Enter the following code into the Add button’s Action event:

The first part of the expression, ListURL.Addrow calls a built-in method belonging 
to a ListBox. The AddRow method is a command that adds a row of text to the end 
of whatever list is already in the ListBox. Not surprisingly, it needs to be passed the 

Line containing the 
error

Syntax error in Tips 
bar

ListURL.Addrow SelectedURL.Text
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Testing the Application
text of the new item. We already know that SelectedURL.Text refers to the con-
tents of the EditField, so that is what we use.

Note A method is a command that performs an action. Technically, ShowURL is a global 
method because it isn’t attached to any particular object. It can be called by any 
object that can call a method. We just happen to be calling it from a PushButton. 
(We could, for example, design the application so that ShowURL is called when the 
user chooses a menu item instead of clicking a button.) 

Just as objects can have properties (like their name, size, position, and label), they 
can also have their own methods. AddRow is also a method but it “belongs” only to 
ListBoxes. It has a specialized action that only makes sense when applied to lists in 
ListBoxes.

The Delete 
Button

The Delete button removes the selected item in the ListBox. It’s also pretty simple.

1 In the Code Editor, expand the DeleteURL item and highlight the Action item.

2 Enter the following line of code:

In this case, we are calling the built-in RemoveRow method of the ListBox control. 
Instead of text, it needs the number of the row (line) to delete. The ListIndex prop-
erty contains that number, so we pass that number to the RemoveRow method.

The ListBox The ListBox itself has the job of copying the item the user selects into the EditField 
so the user can connect to that URL or email address. You can easily do this by 
writing an assignment statement that runs when the user highlights an item in the list. 

1 Expand the ListURL item in the Code Editor browser area and select the Change 
event handler. 
The Change event runs whenever a different item is highlighted in the ListBox.

2 Enter the following code into the Change event:

The ListBox’s Text property contains the text of the highlighted item. The Text 
property of SelectedURL contains the text that’s currently displayed. This assign-
ment statement copies this text into the Text property of the EditField.

Testing the Application
That’s the basics of this application. Now it’s time to test out all these features.

1 Choose File . Save to save your changes.

2 Click the Run button in the Main Toolbar to test it out.

ListURL.RemoveRow ListURL.ListIndex

SelectedURL.Text=ListURL.Text
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Testing the Application
The application looks the same as it did, but all the controls work! For example, 
enter http://www.realsoftware.com into the EditField and click the Add but-
ton. Add a few other URLs to the ListBox in this manner and then highlight one in 
the ListBox to move it to the EditField.

Figure 26. Clicking a URL to move it to the EditField.

You can:

n Enter a URL into the EditField and connect to the site using your default web 
browser.

n Add the URL to the ListBox.

n Select any URL in the ListBox to copy it into the EditField.

n Delete the selected URL in the ListBox.

If you want to send an email, enter it in the following way:

If the 
Application 
Doesn’t Run

If something is wrong with your code, REALbasic stops and points out the first 
error it finds when you clicked the Run button in the Toolbar. For example, in 
Figure 27 this user has entered the name of a general class of objects (“ListBox”) 
rather than the particular ListBox itself:

mailto: username@domain.com
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Testing the Application
Figure 27. A vocabulary error.

In most cases, you will find that errors are due to either misspelling the name of an 
object or the name of a property. You will also get errors if you use the intended 
name of an object but did not change the default name of the object in the Proper-
ties pane. Start by checking the term that REALbasic highlights and determine 
whether it is spelled correctly. If it is supposed to be the name of a control, be sure 
the control as been renamed correctly. If it is the name of a method (like “ListIn-
dex”) be sure it is spelled correctly.

Of course, you need to correct the error before the application can run. Each time 
you test the application, REALbasic will stop at the first error, so there may be 
others.

Using 
Autocomplete

One way to avoid using incorrect terms is to take advantage of REALbasic’s 
“autocomplete” feature. As you type, REALbasic tries to guess what you are typing. 
If you type the first few characters of a REALbasic language object — either built-in 
or a variable, method, or property that you created — it shows its guess in light 
gray type. If the guess is correct, press the Tab key to complete the entry.
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Testing the Application
If there is more than one possibility, REALbasic displays a contextual menu when 
you press Tab. Here is an example:

Figure 28. Autocomplete in action.

The user has just typed “List” and pressed the Tab key. REALbasic displays a 
contextual menu with all the possible terms that complete the expression. Use the 
Up and Down arrow keys to navigate through the list and then press the Enter key 
(Return on Macintosh) to select the highlighted term.

How can the 
Application 
be Improved?

Although all the controls do their jobs, they do their jobs when it is inappropriate 
to do so. For example,

n If the EditField is blank, clicking the Add button adds a blank row to the ListBox 
and clicking the Connect button tries to open a non-existent URL.

n If no item is selected in the ListBox, the Delete button tries to delete a non-existent 
row.

We should make it impossible for the buttons to be clicked unless the conditions 
are right or, at least, give the user some appropriate feedback.

1 Choose File . Exit on Windows or Linux (or MyApplication . Quit on Mac OS X) 
to return to the REALbasic IDE and select the Window editor tab.

2 In the Code Editor browser area, open the Connect button’s Action event.
It currently reads:

We need to make this conditional — so that the line is executed only when there is 
some text in the EditField. For now, we’ll have to assume that the user knows how 
to enter a valid URL or email address.

ShowURL SelectedURL.Text
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Testing the Application
3 Modify the code to read:

There is no space between the double quote marks in the first line or between the 
less than and greater than signs.

This code first tests to see whether the contents of the EditField is blank. The “<>” 
symbol means “not equal to” and the two quotes with nothing in between specify 
blank text. This If statement tests whether the EditField is not empty. If the 
EditField has text in it, the ShowURL method is called normally. 

The Else statement handles the case when the EditField is empty. If the EditField is 
blank, we use the MsgBox command to display an alert box with an informative 
message.

4 Expand the DeleteURL item in the Code Editor and select the Action event.
We need to follow the same logic. This code should run only if the user has selected 
an item in the ListBox—not all the time.

5 Modify the code to read as follows:

6 Expand the AddURL item in the Code Editor and select the Action event.
In this case, we can add an extra test. If the item is already selected, it doesn’t need 
to be added, so we can test for that condition as well. The first test prevents the Add 
button from adding a blank row and the second test prevents it from adding a 
duplicate row (We could also write a separate method that tests whether the new 
item matches any item in the ListBox, but we will leave that as an exercise!)

7 Modify the code to read as follows:

Next, we want to prevent the user from using the Add and Connect buttons if there 
is nothing in the EditField.

If SelectedURL.Text <> "" then
ShowURL SelectedURL.Text

Else
MsgBox "Please enter a URL or email address."

End if

If ListURL.Text <> "" then
ListURL.RemoveRow ListURL.ListIndex

Else
MsgBox "Please select an item in the list."

End if

If SelectedURL.Text <> ListURL.Text then
ListURL.Addrow SelectedURL.Text

Else
MsgBox "Please enter a different URL or email address."

End if
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Testing the Application
8 Expand the SelectedURL item in the Code Editor and select the TextChange event 
handler in the Browser area of the Code Editor.

The TextChange event runs whenever the text in the EditField has changed. We 
want to take action based on the EditField’s state just after the text has changed. If 
the EditField is now blank, we will disable these two buttons so the user can’t use 
them. And, if there is text in the EditField, we will enable the buttons and make the 
Connect button the default button. The default button has an outline around it on 
Windows, Linux, and Mac OS “classic” and it “throbs” on Mac OS X.

9 Enter the following code into the TextChange event.

One thing you notice about this code is that the first line uses the pronoun “Me” 
instead of the name of the control. “Me” always refers to the control the code belongs 
to; since we are inside the EditField, SelectedURL, “Me” refers to SelectedURL. In 
other words, this line is the same as if we wrote If SelectedURL.Text….

The last step is to modify the code for the ListBox. This code needs to test whether 
the user has highlighted an item before trying to copy text into the EditField. It 
also should manage the Delete and Connect buttons. There’s no reason the user 
should be able to click Delete if no item is selected.

10 Expand the ListURL item in the Code Editor and select the Change event.

11 Modify the code to read as follows:

12 Save the project.

13 Click the Run button in the Main Toolbar to test it out. 
When you first open the application, you can test the alert messages that you’ve put 
in each PushButton. Then add a URL and see how the application behaves.

14 When you’re finished, quit out of the test application and return to the REALbasic 
IDE.

If Me.Text <> "" then
ConnectURL.Enabled=True
ConnectURL.Default=True
AddURL.Enabled=True

Else
ConnectURL.Enabled=False
ConnectURL.Default=False
AddURL.Enabled=False

End if

If Me.Text <> "" then 
SelectedURL.Text=ListURL.Text
ConnectURL.Enabled=True
DeleteURL.Enabled=True

Else
DeleteURL.Enabled=False

End if
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Building A Standalone Application
If the 
Application 
Doesn’t Run

This section introduces the If…Else…End if statement. The Code Editor automati-
cally indents the code within an If statement to make it easy to check your code. Be 
sure that your code is indented as shown in the instructions. Be sure there is an “End 
If” statement for each “If” and you didn’t type “Endif” instead of “End if” or “end 
if”. Capitalization doesn’t matter, but the space between “End” and “if” does. Also, 
check that each line that begins with an “If” statement ends with “then”. Also, you 
should not leave a blank space between the double quote marks or between the less 
than and greater than signs.

Building A Standalone Application
Now that you have a finished version of the application, you’re ready to create a 
standalone application. The standalone version of the application runs just like the 
application you’ve been testing, but it doesn’t require the REALbasic application 
itself. It can be double-clicked from the desktop, just like a commercial application.

The Professional version of REALbasic can create standalone applications for the 
Windows, Macintosh, and Linux platforms. The Standard version of REALbasic 
builds standalone applications only for the platform on which the REALbasic IDE is 
running. It also allows you to build demo versions for the platforms on which 
REALbasic is not running. A demo version is fully functional but quits automati-
cally after five minutes.

Building Your 
Application

Building a stand-alone version of your project as an application couldn’t be easier 
than it is in REALbasic. 

1 Click the Build button in the Main Toolbar. 

REALbasic compiles your project, creates a standalone application, and brings it to 
the front window. 

Figure 29. The URL Manager built application icon (Windows).

By default, it uses the name “My Application” and uses your platform’s generic 
application icon. Both the name and icon can be customized easily. 

2 Double-click the “My Application” icon and try out the program. When finished, 
choose Quit to put away the URL Manager and go back to the REALbasic project.

Customizing 
the Standalone 
Application

Before building a standalone application, you can set several options. For example, 
you can change the application’s name, build for other platforms, set memory 
requirements for Mac OS 8-9, and some other options. 

You choose the platforms on which you build your application in the Build Settings 
dialog box. 
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Building A Standalone Application
1 Choose Project . Build Settings.
The Build Settings dialog box appears.

Figure 30. The Build Settings dialog.

2 If you have other computer platforms available, select them and click OK.

You use the properties of the App object to choose your platform-specific settings. 

Click the Project tab in the Tabs bar and then click the App object to display its 
properties in the Project Editor’s Properties pane. (You can drag the divider to the 
left to enlarge the Properties pane, as shown in Figure 31.)

Figure 31. The properties of the App class.

In the Windows, Linux, and Mac settings areas, you set the name of the built appli-
cation and, in most cases, some other properties.
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What’s Next
3 Enter URL Manager.exe for Windows or URL Manager for Macintosh and Linux 
as the name of the application for the OS that you’re using. 

4 Click the Build button in the Main Toolbar.
REALbasic compiles the application, saves the built application to a file on your 
computer, and opens the window containing the built application.

Quit out of the REALbasic IDE (File . Exit on Windows and Linux or 
REALbasic . Quit on Mac OS X).

5 Double-click the new application and try it out. 

6 If you built versions for other platforms, drag them to those platforms as well.
For example, Figure 32 shows the application running under Linux and 
Windows XP™.

Figure 32. The Linux and Windows versions of the URL Manager application.

What’s Next
The QuickStart shows how easy it is to develop a simple application. In the Tutorial, 
you build a more elaborate application — a text processor that supports styled text, 
creating, opening, and saving files, and printing. It illustrates more REALbasic fea-
tures, including sheet windows and dialog boxes, menus and menu items, writing 
and calling methods, and compiling platform-specific code.

With the skills you’ll learn in the Tutorial, you’ll be able to add a File menu to this 
application with Open and Save items that will allow you to save URL lists to disk 
and open saved lists. Another way to save URL lists is to use a database. REALbasic 
includes a database that can be used for this purpose. It is described in the User’s 
Guide.

Also, be sure to check out the REALbasic web site at http://www.realsoftware.com 
for other tutorials and how-to’s. 
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